
Living with Computers TRM238

Chapter 1

Networking

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 A computer network could be  wired  or wireless.
		  (b)		 By using networking, one computer can be given an Internet 

connection and others can share the high bandwidth and 
access the Internet.

	 	 (c)	 A computer network allows individual users and files to be 
password protected so that no unauthorised access can 
take place.

		  (d)	 Computer Network components are the major parts that are 
needed to install a network both at the office and at home.

		  (e)	 Network Security controls are designed to prevent 
unauthorised personnel from gaining physical access to the 
components of a network.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 Network types can be defined on the basis of 

network size, their capabilities and the geographical 
regions they cover.	 T

		  (b)	 LAN stands for Later Area Network.	 F
		  (c)	 A Wide Area Network (WAN) is a network that exists 

over a large geographical area.	 T
		  (d)	 When you want to share a single Internet connection to 

multiple computers, you will use a modem.	 F
		  (e)	 Hub is a device that splits a network connection into 

multiple computers.	 T
3.	Tick () the correct option.
	 Ans.	 (a)	 PAN stands for Personal Area Network.
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	 (i)	 Permanent Area Network
	 (ii)	 Proper Area Network
	 (iii)	 Permanent Account Number
	 (iv)	 Personal Area Network
		  (b)	 Administrative security controls consist of security policies 

and processes that control user behaviour, including how 
users are authenticated.

	 (i)	 Technical security	 (ii)	 Physical security
	 (iii)	 Administrative security	 (iv)	 Data security
		  (c)	 PAN enables communication among computer devices within 

the range of   10    metres.
	 (i)	 30	 (ii)	 20
	 (iii)	 10	 (iv)	 5
		  (d)	 NIC stands for Network Interface Card.
	 (i)	 Network Internet Case	 (ii)	 Network Interface Card
	 (iii)	 Network Internet Card	 (iv)	 Network Interface Case
		  (e)	 The  wired  network uses special type of cables to connect 

computers on a network.
	 (i)	 wired	 (ii)	 wireless
	 (iii)	 both (i) and (ii)	 (iv)	 None of these
4.	Answer the following questions.
	 (a)	Write briefly about MAN.
	 Ans.	 �Metropolitan Area Network (MAN) is similar to LAN but spans an 

entire city. For example, all branches of an office in a big city are 
connected to each other through MAN.

	 	 Several MANs can be connected over the world through the  
Internet.

	 	 The advantages of MAN include sharing of data and resources, 
decreased   travel cost, etc. The disadvantages of MAN include 
security problems, high setup cost, etc.
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	 (b)	 Differentiate between a hub and a switch.
	 Ans.	� A hub/switch is a device that splits a network connection among 

multiple computers. When a computer requests information from 
a network or a specific computer, it sends the request to the hub 
through a cable. The hub receives the request and transmits it on 
the entire network. Each computer on the network should then 
figure out whether the broadcast data is for it or not. A switch is 
more expensive than a hub.

	 (c)	 Explain any four advantages of a network.
	 Ans.	 Advantages of a Network:
		  	 Resource Sharing: All computers in a network can share  

resources such as printers, fax machines, modems and 
scanners. There are many times when you need to print some 
work from different computers connected through networking. 
In such a case, you need not attach a separate printer with 
each computer. You can share the same printer connected to 
all the computers over a network. 

		  	 File Sharing: Networks offer a quick and easy way to share files 
directly. Instead of using a disk or USB key to carry files from 
one computer or office to another, you can share files directly 
using a network.

		  	 Flexible Access: Networks allow users to access files from 
computers throughout the network. This means that a user 
can begin work on a project on one computer and finish it on 
another. Multiple users can also collaborate on the same project 
through the network.

		  	 Cost Effective: Since resources and files can be shared over a 
network, cost automatically goes down. For example, many 
popular software products are available for networks at a 
substantial savings in comparison to buying individually 
licensed copies for all your computers.

	 (d)	 Mr Nayyar owns a company. His office has different departments 
that are spread over two adjoining buildings.  He wants to connect 
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computers over all the departments in both the buildings for quick 
and efficient data transfer. Suggest an economical method of 
networking to him.

	 Ans.	 �Mr Nayyar can use a LAN.
	 (e)	 Differentiate between PAN and LAN.
	 Ans.	 �PAN or Personal Area Network enables communication between 

computer devices within the range of a person covering an area of 
approximately 10 meters.

		  LAN or Local Area Network can be used to connect to a larger area 
as compared to PAN. It can be a group of buildings in the same 
area or one floor to another in the same building.

COMPUTER TIME

Find out if the computers in your school are connected to any kind 
of networking. If yes, with the help of your teacher, find out the type of 
networking, networking devices and cables used. Write the details in your 
notebook. Also, find out how this equipment is maintained over a long 
period of time.
	 Ans.	 Do it yourself.

Answers of Suggested Class Activities
	 Ans.	 N A C J W J D C P R X

E S N X C S Z C Z M S
T A K B E H U B E O U
W I R E D A E M P D E
O D A Z A R O U T E R
R W J C T I J C O M U
K I M L A N I V Z L K
I X A I N G P H W U P
N J H E Y N L W D D H
G T A N C T D Z K N K
G G L T I A Z C G B Q
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Answers of Worksheet

	 I.  	 1.  network  2.  router  3.  LAN  4.  wireless  5.  server
	 II.  	 1.  F  2.  F  3.  T  4.  T  5.  F
	 III.  	 1.  (c)  2.  (d)  3.  (c)  4.  (a)  5.  (d)
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Chapter 2

More on Photoshop

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Photoshop is an image editing software that allows users to 

manipulate, crop, resize, and correct colour on digital photos.
		  (b)	 Lasso tool allows you to create free-hand selections.
		  (c)	 If you press the Shift and Selection tool keys simultaneously, 

you get an intersection of the old and new selections.
		  (d)	 The Pencil tool draws free-form lines with a hard edge.
		  (e)	 The Heading Brush tool allows you to fix image imperfections.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 Areas outside a selection are protected from change 

in Photoshop.	 T
		  (b)	 You cannot make a circular selection using the Elliptical 

Marquee tool.	 F
		  (c)	 For working on different layers, you first need to select 

them.	 T
		  (d)	 The Auto Eraser parameter is only available for the 

Brush tool.	 F

		  (e)	 We can work on multiple layers at a time.	 T
3.	Tick () the correct option.
	 Ans.	 (a)	 You will use the   Crop   tool if you only want a part of an image 

and not the whole image.
	 (i)	 Selection	 (ii)	 Crop
	 (iii)	 Rectangular marquee	 (iv)	 Lasso
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		  (b)	 The Magic Wand tool selects a consistently coloured area.
	 (i)	 Magic Wand	 (ii)	 Spot Healing
	 (iii)	 Blur	 (iv)	 Smudge
		  (c)	 The Clone Stamp tool in Photoshop can be used to clone 

areas from an image and blend the pixels from the sampled 
area seamlessly with the target area.

	 (i)	 Pattern Stamp
	 (ii)	 Healing Brush 
	 (iii)	 Spot Healing Brush
	 (iv)	 Clone Stamp
		  (d)	 In the Options bar, the Shadows option changes the dark 

areas.
	 (i)	 Midtones	 (ii)	 Shadows
	 (iii)	 Highlights	 (iv)	 None of these
		  (e)	 100% opacity means the pixels are not erased at all.
	 (i)	 erasing pixels completely
	 (ii)	 making image semi-transparent
	 (iii)	 making image blur
	 (iv)	 the pixels are not erased at all

4.	Answer the following questions.
	 (a)	 How does resizing handles work in Photoshop?
	 Ans.	� Wherever a picture is selected using the Crop tool, on the corners 

of the selection and on midpoints of sides, tiny squares appear. 
These are called resizing handles. They can be used to increase/
decrease the size of the area you want to crop.

	 (b)	 Differentiate between the Dodge and Burn tools of Photoshop.
	 Ans.	� Dodging and burning are techniques used to improve the 

appearance of photographs. The term ‘Dodging’ refers to lightening 
an area of the image while ‘Burning’ is darkening of the image. 
The more you paint over an area with the Dodge or Burn tool, the 
lighter or darker it becomes.
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	 (c)	 What is the role of filters in Photoshop? Explain briefly with the help 
of an example.

	 Ans.	� You can use filters to clean up or retouch your photos, apply special 
art effects that give your image the appearance of a sketch or create 
unique transformations using distortions and lighting effects. The 
filters provided by Photoshop appear in the Filter menu.

	 (d)	 Write briefly about the following:
		  (i)	 Attributes of the background layer
		  (ii)	 Eraser tool
	 Ans.	 (i)	 The following are the attributes of the background layer:
		  	 Stacking order
		  	 Blending mode
		  	 Opacity
			   To change the above attributes, we first need to convert the 

background layer into a regular layer.
		 (ii)	 The Eraser tool is basically a brush which erases pixels as you 

drag it across an image. Pixels are erased to transparency 
or the background colour if the layer is locked. It has three 
variations: Eraser, Background Eraser and Magic Eraser.

			   When you select the Eraser tool, you have the following options 
available in the Options bar:

			   Brush:  Options include the size of the eraser, hardness of the 
edges and various styles. 

			   Mode:  There are three options: Brush (soft edges), Pencil 
(hard edges) and Block (square brush size).

			   Opacity:  100% opacity erases pixels completely, 50% is semi-
transparent (or coloured), 0% does not erase at all. 

			   Flow:  This determines how quickly the erasure is applied by the 
brush. Lower settings produce a more subtle effect. This option 
is available only in the Brush mode.

			   Airbrush:  This option allows you to use the eraser as an airbrush 
available only in the Brush mode.
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	 (e)	 Which tool helps you soften an image using Photoshop? How do 
we use the tool?

	 Ans.	 The Blur tool can be used to soften images, blur out a background 
or create a soft tone in a photograph or image. Follow these steps 
to use this tool:

			   1.	 Open an image.
			   2.	 Select the Blur tool. 
			   3.	 Now, select the Brush size, Mode and Strength values 
				    from the Options bar.
			   4.	 Drag the mouse at the required area to get the desired result.

COMPUTER TIME

Do the following activities using Photoshop:
	 (a)	 Create a collage on ‘Save Earth’ by using different pictures related to 

the topic. Use appropriate Photoshop tools to complete the task.
	 Ans.	 Do it yourself.
	 (b)	 Collect pictures of different types of fish and create an image of an 

aquarium using appropriate tools.
	 Ans.	 Do it yourself.
	 (c)	 Create a greeting card for your friend on her birthday using Photoshop 

tools.
	 Ans.	 Do it yourself.
	 (d)	 Create a poster on the topic ‘Save Tigers’. Also, think of a few catchy 

slogans relevant to the topic and insert them on the poster.
	 Ans.	 Do it yourself.

Answers of Suggested Class Activities
 	 A.	 1.  (c)  2.  (d)  3.  (c)  4.  (b)  5.  (d)
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Answers of Worksheet

	 I.	 1.  darken  2.  erases  3.  Healing Brush  4.  Smudge  5.  soften
	 II.	 1.  T  2.  T  3.  F  4.  F  5.  F
	 III.	 1.	 Yes, it is possible. Follow these steps to select one or more layers:
	 1.	 To select a single layer, just click on that layer.
	 2.	 To select all the layers, click on Select > All layers options 

from the menu. 
	 3.	 You can also select multiple adjacent layers by clicking 

different layers while pressing the Shift key from the keyboard.
		  2.	 Top Layer
		  3.	 To change the name of a layer, follow the given steps:
	 1.	 In the layers panel, double-click on the name of the layer.
	 2.	 Type the new name that you want to give to the layer.
		  4.	 The Spot Healing Brush is the default healing tool in Photoshop 

and can be used to clone areas from an image and blend the 
pixels from the sampled area seamlessly with the target area.

		  5.	 To convert a layer into background, follow these steps:
	 1.	 Select any layer that has to be converted into background from 

the layers panel.
	 2.	 Now, click on Layers followed by New and select the 

background from the Layer option.
	 3.	 You will notice that transparent pixels in this layer are 

converted to the background colour and the layer is at the 
bottom of the layer stack.
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Chapter 3

More About HTML - Links

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Hyperlinks allow users to move seamlessly from one page to 

another.
		  (b)	 A link has two ends, called anchors.
		  (c)	 A local is a link to the same web site and is specified with a 

relative URL.
		  (d)	 Attributes are added to a tag to provide the browser with 

more information about how the tag should appear or behave.
		  (e)	 The target attribute specifies where to open the linked 

document.

2.	Write True (T) or False (F).

	 Ans.	 (a)	 A link can never be an image element.	 F
		  (b)	 The href attribute specifies the destination address of 

the link.	 T
		  (c)	 Attributes consist of a name and a value separated by 

an ampersand (&) sign.	 F

		  (d)	 Links can also be styled as buttons. 	 T
		  (e)	 The path to an audio file can contain an absolute or 

relative URLs.	 T

3.	Tick () the correct option.
	 Ans.	 (a)	 When you move the mouse over a link, the mouse arrow will 

turn into a little   hand  .
	 (i)	 finger	 (ii)	 hand
	 (iii)	 foot	 (iv)	 ball
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		  (b)	 A link starts at the   source   anchor. 
	 (i)	 source	 (ii)	 starting
	 (iii)	 destination	 (iv)	 target
		  (c)	 Hyperlinks are defined with the HTML   <a>   tag.
	 (i)	 <d>	 (ii)	 <c>
	 (iii)	 <b>	 (iv)	 <a>
		  (d)	 A/an   unvisited   link is underlined and blue.
	 (i)	 visited	 (ii)	 unvisited
	 (iii)	 active	 (iv)	 inactive
		  (e)	 The blank target attribute opens the linked document in a 

new window.
	 (i)	 new window	 (ii)	 same window
	 (iii)	 parent frame	 (iv)	 named frame

4.	Answer the following questions.
	 (a)	 Name the three accepted formats of a sound file for the <audio> tag.
	 Ans.	� Autoplay, controls, loop.
	 (b)	 Discuss and write about any three attributes of the <video> tag.
	 Ans.	 The following table describes three attributes of the <video> tag:
	 Attribute Description
autoplay It lets the video file to be played immediately after it loads.

controls It checks what controls are to be displayed with the video 
player.

height It is used to give the height of the video player.

	 (c)	 Define unvisited, visited and active links.
	 Ans.	� Unvisited links are hyperlinks that are not opened yet. They are 

underlined and blue in colour, by default.
		  Visited links are hyperlinks of websites that are already viewed. 

They are underlined and purple in colour.
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		  Active links are the hyperlinks that are currently open or active. 
They are underlined and red in colour.

	 (d)	 Write the syntax to add a link on a web page with the help of an 
example.

	 Ans.	� Syntax: <a href = “indiagate.html> India Gate <|a>
		  In the above example, the text ‘India Gate’ is hyperlinked to the web 

page www.indiagate.html. By clicking as this text, a web page with 
information about India Gate would open.

	 (e)	 With the help of an example, write the code in HTML to create an 
image link on a web page.

	 Ans.	� <a href=“flowers.html”><img src = “flower.jpeg” height = “30” width 
= “flower.jpeg” height = “30” width = “30”><|a>

		  A thumbnail image of flower is converted into an hyperlink which, 
when clicked, would open a web page named flowers.html.

COMPUTER TIME
Namit has created two web pages, one on ‘Plastics are Harmful’ and 
another on ‘Different Plastic Materials and their Harmful Effects’. Help 
Namit to do the following:
	 (a)	 Create a link between the two web pages;
	 (b)	 Insert an appropriate audio on the first web page.
	 (c)	 Insert a picture hyperlink on the second web page to go back to the 

first web page.
	 (d)	 Write HTML code that Namit would follow to create these web 

pages.
	 Ans.	 Do it yourself.

Answers of Suggested Class Activities
 	 1.	 (b)  2.  (c)  3.  (d)  4.  (a)

Answers of Worksheet
	 I.	 1.  visited  2.  hyperlink  3.  loop  4.  <video>  5.  <audio>
	 II.	 1.  T  2.  F  3.  F  4. T  5.  T
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	 III.	 1.	 The anchor tag, <a>, is used to create a link on a web page. Two 
attributes of this tag can be: href and link.

		  2.	 A local link is a link to the same web site and is specified with a 
relative URL (without https://www....).

			   Example:

		  3.	 HTML tags can contain one or more attributes. Attributes are 
added to a tag to provide the browser with more information about 
how the tag should appear or behave. Attributes consist of a name 
and a value separated by an equal to (=) sign, with the value 
surrounded by double quotes. For example, style=”color:black;”. 
You can change the default colours

		  4.	 An active link is the hyperlink page that is currently open and the 
default colour of such a link is red. A visited link is the hyperlink 
that is already visited by the user and the default colour of a 
visited link is purple.

		  5.	 The src attribute of the <audio> tag links to the URL of the audio 
file. The control attribute checks what controls are to be displayed 
with the audio player.



Living with Computers TRM264

TESTING TIME – 1
(BASED ON LESSONS 1 TO 3)

1.	Fill in the blanks.
	 Ans.	 (a)	 All computers in a network can   share   resources.
		  (b)	 PAN stands for   Personal Area Network  .
		  (c)	� Rectangular and Elliptical are type of   marquee   tool in 

Photoshop.
		  (d)	� In Photoshop, the   Clone stamp   tool is also called the Rubber 

Stamp tool.
		  (e)	� The   href   attribute of the <a> tag in HTML specifies the 

destination web address.

2.	Name the following.
	 (a)	 Photoshop tool that draws lines with soft edges.

	 Ans.	 Brush tool
	 (b)	 Internet is an example of this type of networking.

	 Ans.	 WAN
	 (c)	 A Photoshop tool that allows you to fix image imperfections such 

as scratches, blemishes, etc.

	 Ans.	 Healing Brush tool
	 (d)	 A Photoshop tool that helps in lightening an area of an image.

	 Ans.	 Dodge tool
	 (e)	 HTML tag to create hyperlinks.

	 Ans.	 <a> tag
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	 3.	 Match the following.
	 Ans.	 (a)	 Communicate over internet	 (i)	 Picture correction 
						     tools
		  (b)	 First known networking	 (ii)	 Blog
		  (c)	 Weblog	 (iii)	 Instant Messaging
		  (d)	 Dodge & Burn	 (iv)	 Background Eraser 
						     tool
		  (e)	 Background colour of	 (v)	 ARPANET
			   an image

4.	From the following grid, find the names of any six Photoshop tools.

	 Ans.	 A H E A L I N G C B

D T S M U D G E E L

O Y E R A S E R A U

D P Y A Y R S B Y R

G E C B U P S T E S

E A R T Y V B N O U

B R T Y U I R F D P

A N M U P O Y R H L

A R E B J L M P O J
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Chapter 4

Programming with Python

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Python provides us  inbuilt functions  to read input from the 

keyboard.
		  (b)	 The  input()  function first takes the input from the user and 

then evaluates the expression.
		  (c)	  Decision making  statements in programming languages 

decide the direction of flow of program execution.
		  (d)	 The if statement accepts  boolean  values.
		  (e)	 Python uses  indentation  to identify a block.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 The text or message displayed on the output screen 

to ask a user to enter input value is mandatory.	 F
		  (b)	 The if statement is the most simple decision making 

statement.	 T
		  (c)	 We can use the else statement with the if statement to 

execute a block of code when the condition is false.	 T
		  (d)	 We cannot nest if statements within if statements in 

Python.	 F
		  (e)		 As soon as one of the conditions controlling the if is 

true, the statement associated with that if is executed, 
and the rest of the ladder is bypassed.	 T

3.	Tick () the correct option:
	 Ans.	 (a)	 The keyboard shortcut to execute the active script in Python 

is   F5  .
	 (i)	 F2	 (ii)	 F3
	 (iii)	 F4	 (iv)	 F5
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		  (b)	 In Python, the   while   loop is used to execute a block of 
statements repeatedly until a given condition is satisfied.

	 (i)	 while	 (ii)	 for
	 (iii)	 infinite	 (iv)	 pass
		  (c)	 NOP stands for   No Operation   in Python.
	 (i)	 No Performance	 (ii)	 No Printing
	 (iii)	 No Operation	 (iv)	 No Output
		  (d)	 When you put a   break   statement in the body of a loop, the 

loop stops executing, and control shifts to the first statement 
outside it.

	 (i)	 pass	 (ii)	 break
	 (iii)	 continue	 (iv)	 loop
		  (e)	 Ctrl + T creates a tab in the work area of the Python Editor 

for the new script.
	 (i)	 loads the selected script in the Python Editor work area
	 (ii)	 closes the active script in the Python Editor work area
	 (iii)	 executes code or a script, depending on whether code is 

highlighted
	 (iv)	 creates a tab in the work area of the Python Editor for 

the new script

4.	Answer the following questions.
	 (a)	 What is the use of pass statement in Python?
	 Ans.	� When we need a particular loop, class, or function in our program, 

but don’t know what goes in it, we place the pass statement in it. 
It is a null statement which, when executed, leads to nothing. The 
interpreter does not ignore it but  performs a no operation (NOP).

	 (b)	 Name the decision making statements used in Python.
	 Ans.	� The decision-making statements in Python are: if, if else, nestled 

if, and if-else-if.
	 (c)	 Explain the while loop in Python with an example.
	 Ans.	� In Python, the while loop is used to execute a block of statements 
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repeatedly until a given condition is satisfied. And when the 
condition becomes false, the line immediately after the loop in the 
program is executed.

		  Syntax
		  while expression:
		  statement(s)
		  All the statements indented by the same number of character 

spaces after a programming construct are considered to be part of 
a single block of code. Python uses indentation as its method of 
grouping statements.

			   Example 	

	 (d)	 Write briefly about the infinite loop.
	 Ans.	 Infinite Loop:  While using a while loop, if you forget to increment 

the counter variable in Python, or write a faulty logic, the 
condition may never become false. In such a case, the loop 
will run infinitely, and the conditions after the loop will never 
be executed.  To stop execution,  press Ctrl+C. However, 
an infinite loop may actually be useful for cases when a 
semaphore is needed, or for client/server programming.  
A semaphore is a variable used solely for synchronisation in 
accessing shared resources.

	 (e)	 How does the input function work in Python?
	 Ans.	 Break Statement:  When you put a break statement in the body 

of a loop, the loop stops executing, and control shifts to the first 
statement outside it. You can put it in a for or while loop.

The input( ) function (Prompt)
The input( ) function first takes input from the user and then evaluates the 
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expression, which means Python automatically identifies whether the user 
entered a string, a number or a list. If the input provided is not correct, then 
a either syntax error or an exception is raised by Python.

Example  

Output   

Working of the input( ) Function

�	 When the input() function starts its execution, the program flow stops until 
the user gives an input.

�	 The text or message displayed on the output screen to ask a user to enter the 
input value is optional. This means that the system will wait for the input from 
the user but if a message is not given in the program, there will be no physical 
indication of what is being expected from the user.
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�	 Whatever you enter as input, the input function converts it into a string. Even 
if you enter an integer value, the input() function converts it into a string. You 
need to convert it into an integer in your code using a particular command.

COMPUTER TIME

	 1.	 Execute the following Python codes and note down their outputs 
in your notebook:

		  (a)  Program to find if the given number is prime or not.

# Python program to check if the input number is prime or not
num = 407
# take input from the user
# num = int(input(“Enter a number: “))
# prime numbers are greater than 1
ifnum> 1:
   # check for factors
fori in range(2,num):
if (num % i) == 0:
print(num,”is not a prime number”)
print(i,”times”,num//i,”is”,num)
break
else:
print(num,”is a prime number”)
# if input number is less than
# or equal to 1, it is not prime
else:
print(num,”is not a prime number”)
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		  (b) Program to find the factorial of a number entered by the user.

# Python program to find the factorial of a number provided by the user.
# change the value for a different result
num = 7
# uncomment to take input from the user
#num = int(input(“Enter a number: “))

factorial = 1
# check if the number is negative, positive or zero
ifnum< 0:
print(“Sorry, factorial does not exist for negative numbers”)
elifnum == 0:
print(“The factorial of 0 is 1”)
else:
fori in range(1,num + 1):
factorial = factorial*i
print(“The factorial of”,num,”is”,factorial)

	 2.	 Write and execute Python programs for each of the following:
	 1.	 Enter two numbers (num 1 and num 2) and decide whether the first 

number or the second number is bigger.  Also, check and display if 
both the numbers are equal. Repeat this procedure 10 times for a 
different set of numbers each time.

	 2.	 Enter a number and display whether it is even or odd.
	 3.	 Let the user enter his/her year of birth and display his/her age at 

present.
	 Ans.	 Do it yourself.
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Answers of Suggested Class Activities
 	 1.	 Python is a popular programming language. It was created by Guido 

van Rossum, and released in 1991.
		  Python can be used:
		  	 On a server to create web applications
		  	 Alongside software to create workflows
		  	 To connect to database systems
		  	 To handle big data and perform complex mathematics
		  	 For software development
	 2.	 Decision-making statements available in Python are:
		  	 if statement
		  	 if - else statement
		  	 nested if statement
		  	 if - else - if statement
	 3.	� There are situations in real life when we need to make some 

decisions and based on these decisions, we decide what is to be 
done next. Similar situations arise in programming also where we 
need to make some decisions, and based on these decisions, we 
execute the next block of code.

	 4.	 The if() statement is the most simple decision-making statement. 
It is used to decide whether a certain statement or block of statements 
will be executed or not, i.e., if a certain condition is true then a block 
of statements is executed, otherwise not.

		  Syntax:
		  if condition:           
		     # Statements to execute if condition is true
	 5.	 While using a while loop, if you forget to increment the counter variable 

in Python, or write flawed logic, the condition may never become 
false. In such a case, the loop will run infinitely, and the conditions 
after the loop will never be executed. This condition is called the 
infinite loop.
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Answers of Worksheet

	 I.  	 1.	  (i) Output: Both are not equal;
				   (ii) Output:	 2
						     4
						     6
						     8
	 II.  	 1.  F  2.  F  3.  T  4.  F  5.  T
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Chapter 5

Introduction to Database – MS Access 2013

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Facts related to any object in consideration is known as 

  Data  . 
		  (b)	   Field   is the column heading and contains a set of values for 

a single type.
		  (c)	   Value   is the smallest unit in a database.
		  (d)	 Software used to manage a database is called a   DBMS  .
		  (e)	  Queries  can sort, calculate, filter and update data based on 

the results you are looking for.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 Database systems require sophisticated hardware and software 

and highly skilled personnel.	 T

		  (b)	 Reports can also be edited like forms.	 F
		  (c)		 Database templates have replaced the Database 

Wizard found in the older versions or MS Access.	 T
		  (d)	 You cannot modify the design of a table after records 

have been added to it.	 F
		  (e)	 The Navigation Pane helps you organise your database 

objects and is the main means of opening or changing 
the design of a database object.	 T

3.	Tick () the correct option.
	 Ans.	 (a)	 Data accuracy is a comprehensive approach to promoting 

the accuracy, validity and timeliness of the data.
	 (i)	 Data accuracy	 (ii)	 Data quality
	 (iii)	 Data inconsistency	 (iv)	 Data access
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		  (b)	 A form is a database object that can be used to create a user 
interface for a database application.

	 (i)	 qeuery	 (ii)	 report
	 (iii)	 macro	 (iv)	 form
		  (c)	 Modules add functionality to a database.
	 (i)	 Modules	 (ii)	 Tables
	 (iii)	 Queries	 (iv)	 Reports
		  (d)		 The Quick Access Toolbar is a toolbar adjacent to the Ribbon 

that allows one-click access to various commands.
	 (i)	 Status toolbar	 (ii)	 Quick Access Toolbar
	 (iii)	 Navigation Pane	 (iv)	 Backstage view
		  (e)	 The size of Short Text data type is 255 characters.
	 (i)	 2 GB	 (ii)	 1 bit
	 (iii)	 255 characters	 (iv)	 4 bytes

4.	Answer the following questions.
	 (a)	 List any three advantages and three disadvantages of a database.
		  Advantages:
	 Ans.	 1.	� Sharing of Data: In a database, users can share the data 

among themselves. There are various levels of authorisation 
(for example, password) to access the data, and the data can 
only be shared based on the correct authorisation entered by 
the users. Many remote users can also access the database 
simultaneously and share the data among themselves.

		  2.	 Data Integrity: Data integrity means that the data is accurate and 
consistent in the database. Data integrity is very important as 
big organisations are completely dependent upon database 
systems.  Any error in the data can cause a serious disruption 
in the working of the organisation. So it is necessary to ensure 
that the data is correct and consistent in all the databases and 
for all the users. 

		  3.	 Data Security and Privacy: Data security is a vital concept in a 
database. Only authorised users should be allowed to access 
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the database and their identity should be authenticated using a 
username and password. There are levels of database access 
and a user can only view the data he/she is allowed to. 

		  Disadvantages:
	 	 1.	 Increased costs: One of the disadvantages of a DBMS is 

that they require sophisticated hardware and software and 
highly skilled personnel. The cost of maintaining the hardware, 
software, and personnel required to operate and manage 
a database system can be substantial. Training, licensing 
and regulation compliance costs are often overlooked when 
database systems are implemented.

		  2.	 Management complexity: Database systems interface with 
many different technologies and have a significant impact on an 
organisation’s resources and culture. The changes introduced 
by the adoption of a database system must be properly 
managed to ensure that it helps advance the organisation’s 
objectives.

		  3.	 Maintaining efficiency: To maximise the efficiency of the 
database system, you must keep your system updated. 
Therefore, you must perform frequent updates and apply the 
latest patches and security measures to all components.

	 (b)	 Name the tasks that can be performed using a DBMS.
	 Ans.	� Data Definition:  It helps in organising data into various types so 

that a relation can be set for accessing information.
		  Data Updation:  It helps in insertion, modification and deletion of 

the data in the database.
		  Data Retrieval:  It helps in taking out relevant information from the 

stored data in an organised manner.
	 (c)	 What is a primary key? How can a primary key be defined in a 

table?
	 Ans.	� A primary key is a field or a set of fields that needs to be unique. 

This can be a unique identification number such as a Medicare 
number, employee ID number, pension number, etc.
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		  Defining Primary Key in a Table:
		  1.	 Select the table in the Navigation Pane.
		  2.	 In the Design tab, click on the down-arrow under the Views 

option and choose Design View.
		  3.	 Click on the field which you want to set as primary key.
		  4.	 Click on the Primary Key button present next to Views button.
		  5.	 You can also right-click on the field name and choose the Primary 

Key option from the context menu. It is a toggle button, i.e., 
clicking once will set the field as primary key and clicking again 
will remove the primary key setting.

	 (d)	 Discuss briefly a few data types available in MS Access 2013.
	 Ans.	 Data types available in MS Access 2013

Type of Data Description
Short Text Text or combination of text and numbers, including numbers 

that do not require calculation (e.g. phone numbers).

Long Text Lengthy text or combination of text and numbers.

Number Numeric data used in mathematical calculations.

Date/Time Date and time values for the years 100 through 9999.

Type of Data Description

Currency Currency values and numeric data used in mathematical 
calculations involving data with one to four decimal places.

AutoNumber A unique sequential (incremented by 1) number or random 
number assigned by Microsoft Access whenever a new record 
is added to a table.

Yes/No Yes and No values and fields that contain only one of the two 
values (Yes/No, True/False, or On/Off).

Attachment Files, such as digital photos. Multiple files can be attached per 
record. This data type is not available in earlier versions of 
Access.

OLE objects OLE objects can store pictures, audio, video, or other BLOBs 
(Binary Large Objects)
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Type of Data Description

Hyperlink Text or combination of text and numbers stored as text and used 
as a hyperlink address.

Lookup Wizard The Lookup Wizard entry in the Data Type column in the Design 
view is not actually a data type. It starts to help you define either 
a simple or complex lookup field.
A simple lookup field uses the contents of another table or a 
value list to validate the contents of a single value per row. A 
complex lookup field allows you to store multiple values of the 
same data type in each row.

Calculated You can create an expression that uses data from one or more 
fields. You can designate different result data types from the 
expression.

	 (e)	 Write the steps to delete a field from a table.
	 Ans.	 Deleting a Field
		  1.	 Change the view to Design View.
		  2.	 Click on the field which you want to delete.
		  3.	 Right-click and choose Delete Rows.
		  4.	 You can also click on the Delete rows button in the Tools group 

under the Design tab.
		  5.	 A  confirmation dialog box appears. Choose Yes to delete the field.
		  6.	 Press Ctrl+S to save the changes.

COMPUTER TIME!

	 1.	 Riddhi has created a table with some fields in MS Access 2013. She 
has given a wrong name to a field by mistake. Can she change the 
name of the field now? If yes, help her to change the name by giving 
the steps for the same.

 	Ans.  Do it yourself.
	 2.	 Madhav has created a table named ‘Class Record’ having the 

following fields: Name of the student, Date of Admission and 
Monthly fee paid. But he does not know the correct data types 
that should be assigned to each field. Help him by suggesting 
correct data types for each field.
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 	Ans.  Do it yourself.

Answers of Suggested Class Activities
	 1.	 A record is the row containing values under each field for one entity.
	 2.	 The software used to manage database is called a Database 

Management System (DBMS).
	 3.	 The topmost part of the Access window which displays name of the 

database and also the name of the software.
	 4.	 Facts related to any object in consideration is known as data. For 

example, your name, age, height, weight, etc., are examples of data 
that is related to you.

Answers of Worksheet

	 I.  	 1.  (c)  2.  (b)  3.  (d)  4.  (d)  5.  (a)
	 II.  	 1.  database
		  2.  confidentiality
		  3.  field
		  4.  Data
		  5.  DBMS
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Chapter 6

More on MS Access 2013

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 The    total    row adds up an entire column of numbers. 
		  (b)	 Data from tables and queries can be presented in a printable 

format called    reports   .
		  (c)		    Sorting    and    Filtering    are two tools that let you 

customize how you organize and view your data.
		  (d)	   Toggling   your filter allows you to turn the filter on and off.
		  (e)	  Quick Search  on data can be done in Access using the 

Record Navigation pane available at the bottom of the MS 
Access screen.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 After you save the sort, the records will stay sorted 

this way until you perform another sort or remove the 
current one.	 T

		  (b)	 The filter searches all of the records in the table, finds 
the ones that meet your search criteria, and permanently 
removes the ones that don’t.	 F

		  (c)	 Click ‘(Blanks)’ to set the filter to find only the records 
with no data in the selected field.	 T

		  (d)	 ‘Columnar’, ‘Tabular’, ‘Datasheet’ and ‘Justified’ are 
type of queries.	 F

		  (e)	 Once you’ve created a form, you can modify it by 
adding additional fields and design.	 T
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3.	Tick () the correct option.
	 Ans.	 (a)	 ‘Totals’ is present in the  Records  group under Home tab.
	 (i)	 Records	 (ii)	 Sort & Filter
	 (iii)	 Clipboard	 (iv)	 View
		  (b)	 After you have set your criteria,  run  a query by clicking the 

Run command on the Design tab.
	 (i)	 view	 (ii)	 select
	 (iii)	 run 	 (iv)	 append
		  (c)	 Preview the report opens a report in the Print Preview mode.
	 (i)	 Detailed	 (ii)	 Print Preview
	 (iii)	 Stepped	 (iv)	 Design
		  (d)	 Report command is present under   Create   tab of the Ribbon.
	 (i)	 Create	 (ii)	 Home
	 (iii)	 External data	 (iv)	 Database tools
		  (e)	 Access sorts records by their ID numbers.
	 (i)	 size	 (ii)	 letters
	 (iii)	 length	 (iv)	 ID numbers

4.	Answer the following questions.
	 (a)	 Name the different layout formats of a report available in MS Access 

2013.
	 Ans.	� Stopped, Block and Outline.
	 (b)	 Differentiate between ‘sorting’ and ‘filtering’ in MS Access 2013.
	 Ans.	 Sorting records means putting records into a logical order with 

similar data grouped together.
		  Filtering allows you to view only the data you want to see. When 

you create a filter, you set the criteria for the data you want to 
display.
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	 (c)	 Why do we use ‘Filter’ in MS Access?
	 Ans.	� Filters are useful because they allow you to focus on specific 

records without being distracted by the data you’re uninterested 
in. For instance, if you had a database that included customer 
and order information, you could create a filter to display only 
customers living within a certain city or only orders containing a 
certain product.

	 (d)	 Write the steps to create a query in MS Access using Query Design.
	 Ans.	� Follow these steps to create a query using Query Design:
		  1.	 Select the Create tab on the Ribbon, and locate the Queries group.
		  2.	 Click the Query Design command.
		  3.	 Access will switch to Query Design View. In the Show Table dialog 

box that appears, select the table you want to run a query on. 
We are running a query about our class record, so we’ll select 
the Class Record table.

		  4.	 Click Add, then click Close.
		  5.	 The selected table will appear as a small window in the Object 

Relationship pane. In the table window, double-click the field 
names you want to include in your query. They will be added to 
the design grid in the bottom part of the screen.

		  6.	 Set the search criteria by clicking the cell in the Criteria row of each 
field you want to filter. (Typing criteria into more than one field 
in the Criteria row will set your query to include only results that 
meet all criteria. If you want to set multiple criteria but don’t 
need the records shown in your results to meet all of them, 
type the first criteria in the Criteria row and additional criteria in 
the or row and the rows beneath it.)

		  7.	 After you have set your criteria, run the query by clicking the Run 
command on the Design tab.

		  8.	 The query results will be displayed in the query’s Datasheet view, 
which looks like a table. If you want you can save your query 
by clicking the Save command in the Quick Access Toolbar. 
When prompted to name it, type the desired name, then click 
OK.
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	 (e)	 Kanishka wants to filter out the students scoring 100 marks in 
Maths. Which feature of MS Access should she use? Write the 
steps that she should follow.

	 Ans.	� Kanishka should use Filter tool of MS Access. The steps to access 
this tool are:

		  1.	 Click the drop-down arrow next to ‘Masks in Maths’.
		  2.	 Now select the checkbox in front of ‘100’.
		  3.	 Click OK.

COMPUTER TIME

	 1.	 Help your sister who is a teacher in a school to record the marks of 
all the students of her class in five subjects. Create a table for the 
same. 

	 2.	 Create queries for filtering the records for students scoring above 90 
as well as below 33.

	 3.	 Sort the data in the descending order of marks. 
	 4.	 Design a form for her to facilitate the data entry process.
	Ans.  Do it yourself.

Answers of Suggested Class Activities
 	 1.	 (b)  2. (d)  3. (a)  4. (a)  5. (b)

Answers of Worksheet

	 I.  	 1.  Home  2.  Queries  3.  Query Wizard; Query Design
		  4.  Filters  5.  Toggling
	 II.  	 1.  F  2.  T  3.  T  4.  T  5. F
	 III.  	 1.	 Data from tables and queries can be presented in printable format 

called reports. 
			   Steps to create a report:
			   (a)	 Open the table or query you want to use in your report.
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			   (b)	 Select the Create tab on the Ribbon. Locate the Reports group 
and then click the Report command.

			   (c)	 Access will create a new report based on your object.
			   (d)	 It is likely that some of your data will be located on the other side 

of the page break. To fix this, resize your fields. Simply select 
a field, then click and drag its edge until the field is of the 
desired size. Repeat with additional fields until all of your 
fields fit.

	   	 2.	 Creating forms for your database can make entering data more 
convenient. When you create a form, you can design it in a way 
that works with your database.

			   Access makes it easy to create a form from any table in your 
database. Any form you create from a table will let you view the 
data that’s already in that table and add new data also. Once 
you’ve created a form, you can modify it by adding additional 
fields and design controls like combo boxes.

		  3.  The ‘Total’ row adds up an entire column of numbers, just like in a 
ledger or on a receipt. The resulting sum appears in a special row 
at the bottom of the table, called the ‘Total’ row.

			   Steps to create a totals row:
			   (a)	 From the Home tab, locate the Records group and click the 

Totals command.
			   (b)	 Scroll down to the last row of your table.
			   (c)	 Locate the desired field for the ‘Total’ row and then select the 

second empty cell below the last record for that field. When 
a drop-down arrow appears, click it.

			   (d)	 Select the function you want to perform on the field data.
			   (e)	 The ‘Total’ row will appear.
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TESTING TIME – 2
(BASED ON LESSONS 4 TO 6)

1.	Tick the correct option.
	 Ans.	 (a)	 A collection of inter-related data.
	 (i)	 Record	 (ii)	 Field
	 (iii)	 Database	 (iv)	 Information
		  (b)	 MS Access window pane helps you organise your database 

objects, and is the main means of opening or changing the 
design of a database object.

	 (i)	 Quick Access Toolbar	 (ii)	 Navigation Pane
	 (iii)	 Ribbon	 (iv)	 None of these
		  (c)	 Putting records in logical order in a database table.
	 (i)	 Sorting	 (ii)	 Filtering
	 (iii)	 Searching	 (iv)	 Creating
		  (d)	 Which of the following is a programming language?
	 (i)	 MS Access	 (ii)	 Adobe Photoshop
	 (iii)	 Python	 (iv)	 Flash
		  (e)	 Which of the following is a decision making statement in 

Python?
	 (i)	 If	 (ii)	 If-else
	 (iii)	 If-else-if	 (iv)	 All of these
2.	State whether true or false.
	 Ans.	 (a)	 A computerised record maintenance system is called the 

DBMS or the Database Management System.	 T
		  (b)	 A table in a database is a row containing values under each 

field for one entity	 F
		  (c)	 Reports in a database software organize and summarize data 

for viewing for printing.	 T
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		  (d)	 Print() statement in Python takes input from the user.	 F
		  (e)		 A loop is used to execute a block of statements repeatedly 

until a given condition is satisfied.	 T

3.	Label any 5 parts of the following MS Access screen:
	 Ans.	

Quick Access Tabs

Ribbon

Status Bar

Navigation Pane

Backstage

4.	Answer the following briefly:
	 (a)	 With the help of an example, differentiate between a field and a 

record in a table.
	 Ans.	 1. � Field: It is the column heading and contains a set of values for a 

single type.
		  2. � Record: It is the row containing values under each field for one 

entity.
	 (b)	 Write steps involved in designing a database.
	 Ans.	� Creating a Database using Templates:  When you click on the 

File → New commands in the MS Access window, it provides a 
readymade template screen to choose from.

		  Database templates have replaced the Database Wizard found in 
older versions of MS Access. Some templates include objects and 
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sample data. The Blank database template does not include any 
pre-defined database objects.

	 (c)	 Give appropriate examples to differentiate between sorting and 
filtering tools of a database software.

	 Ans.	� Example of Sorting:  Assume a table of data with the following 
fields: Name, Class, Marks in Eng, Marks in Maths, Marks in SC, 
Total Marks.

		  If you want to arrange the data in descending order of total marks,  
		  use sorting tool.
		  Example of Filtering:  Display only the students who have scored  
		  100 marks in SC.
	 (d)	 What is the advantage of creating forms in a database? 
	 Ans.	� Creating forms for your database can make entering data more 

convenient. When you create a form, you can design it in a way 
that works with your database.

		  Access makes it easy to create a form from any table in your 
database. Any form you create from a table will let you view the 
data that’s already in that table and add new data also. Once 
you’ve created a form, you can modify it by adding additional fields 
and design controls like combo boxes.

	 (e)	 What is the purpose of break statement in Python? Explain with the 
help of an example.

	 Ans.	 �Break Statement: When you put a break statement in the body 
of a loop, the loop stops executing, and control shifts to the first 
statement outside it. You can put it in a for or while loop.



Living with Computers TRM314

Chapter 7

Developing Apps

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 An  application  is a software program designed to perform 

a specific function directly for the user or, in some cases, for 
another application program.

		  (b)	  Hybrid  apps are mainly website applications disguised in a 
native wrapper.

		  (c)	  Business  apps are also referred to as productivity apps.
		  (d)	  Web  apps redirect a user to a URL and offer the ‘install’ 

option by simply creating a bookmark to their page.
		  (e)	 The mustard yellow blocks in the Blocks Editor window are 

called event handler blocks.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 Native apps are developed for a single mobile 

operating system.	 T

		  (b)	 Hybrid apps are faster than the native apps.	 T
		  (c)	 For developers, the game apps category is the most 

profitable category.	 T
		  (d)	 The purple blocks are called event handler blocks, 

which are placed in the body of event handlers.	 F
		  (e)	 The barcode generated to install an app works only 

for your own device as it is associated with your 
Google account.	 T

3.	Tick () the correct option.
	 Ans.	 (a)	 App is an abbreviated form of the word Application.
	 (i)	 Appliance	 (ii)	 Appearance
	 (iii)	 Application	 (iv)	 Appeal
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		  (b)	 An average gaming session is about     8     minutes long.
	 (i)	 10	 (ii)	 8
	 (iii)	 6	 (iv)	 4
		  (c)	 To ‘package’ the app to your phone or to send it to someone 

else, select the   Build   tab at the top of the screen.
	 (i)	 Build	 (ii)	 Projects
	 (iii)	 Connect	 (iv)	 Help
		  (d)	 Bitmoji, Flashlight, QR Reader are all examples of  utility  

apps.
	 (i)	 gaming	 (ii)	 utility
	 (iii)	 educational	 (iv)	 web
		  (e)	 Click the Blocks button at the upper right of your screen to go 

to the Blocks Editor.
	 (i)	 upper left	 (ii)	 lower left
	 (iii)	 upper right	 (iv)	 lower right

4.	Answer the following questions.
	 (a)	 What is side loading?
	 Ans.	� You can download the app to your computer as an apk file, which 

you can distribute and share as you like by manually installing it on 
other devices. (sometimes called ‘side loading’.)

	 (b)	 Differentiate between hybrid apps and web apps.
	 Ans.	 �Hybrid Apps:  They are built using multi-platform web technologies 

(for example, HTML5, CSS and Javascript). Hybrid apps are mainly 
website applications disguised in a native wrapper. A hybrid app 
combines the elements of both native apps and web applications. 
These apps usually possess the pros and cons of both native and 
web mobile applications.

		  Web Apps: These are software applications that behave like native 
applications. Web apps use a browser to run and are usually written 
in HTML5, JavaScript or CSS. These apps redirect a user to a 
URL and offer the ‘install’ option by simply creating a bookmark to 
their page.
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	 (c)	 What do you mean by the term ‘command’?
	 Ans.	� A command is a block that specifies an action to be performed 

(e.g., playing sound) when the event (e.g., pressing Button1) is 
triggered.

	 (d)	 Write briefly about the following:
		   (i)	 Gaming apps
		  (ii)	 Packaging your app
	 Ans.	  (i)	� These are by far the most popular category among types of 

apps, as more than 24% of all mobile applications, available 
in the App Store, fall into this section.

				   Mobile gaming has always been thriving, prompting app 
developers to invest more time and resources into creating new 
games and mobile versions of well-known stationary games. 
From the user’s perspective, gaming apps offer a sense of 
achievement and high engagement in the process. An average 
gaming session is about 8 minutes long. For developers, the 
game apps category is the most profitable one.

			   Examples: Clash of Clans, Angry Birds Go.
		  (ii)	� To ‘package’ an app to your phone or to send it to someone else, 

select the Build tab at the top of the screen. Under Build there 
are two options available for you to choose from:

			   1.	 App (provide QR code for .apk): You can generate a barcode 
(a QR code), which you can use to install the app on 
a phone or tablet that has a camera, with the aid of 
a barcode scanner, like the ZXing barcode scanner 
(freely available in Google Play).

			   2.	 App (save .apk to my computer): You can download the 
app to your computer as an apk file, which you can distribute 
and share as you like by manually installing it on other 
devices. (sometimes called ‘side loading’.)

	 (e)	 Niti wants to create her first app using MIT App Inventor, but she 
does not know how. Help her by providing her the steps required 
to create the app.
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	 Ans.	 To create your first app with MIT, follow these steps:
		  1.	 Go directly to ai2.appinventor.mit.edu or click the orange button 

‘Create Apps!’ from the App Inventor website.
		  2.	 Log in to App Inventor using Gmail’s (or Google’s) user name and 

password.
		  3.	 Click Continue to dismiss the Splash screen.
		  4.	 Click on Start new project.
		  5.	 Type in the project name (underscores are allowed, spaces 

cannot be used) and click OK.
		  To select components and set properties, follow these steps:
		  1.	 From the User Interface palette, drag and drop the Button 

component to Screen 1.
		  2.	 To give the image of the bee to the button, click on the text None... 

and click Upload File... in the Properties pane, under Image.
		  3.	 A window will pop up to let you choose the image file. Click Browse 

and then navigate to the location of the desired image. Click 
the file, click Open, and then click OK.

COMPUTER TIME

	 1.	 Name any five useful mobile apps installed on your parent’s/
guardian’s mobile. Ask them about any two useful features of 
each app and write about them. Under their guidance, explore 
the apps and write about other features that you find in each app.

	 Ans.	 Do it yourself.
	 2.	 Think of a topic on which you would like to develop an app. Try 

developing an app on the selected topic using MIT App Inventor. You 
may take guidance from its tutorial available online. You can even 
download the PDF version of the tutorial for offline reference. Use 
the following link: https://appinventor.mit.edu/explore/ai2/tutorials.

	 Ans.	 Do it yourself.
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Answers of Suggested Class Activities
Do it yourself.

Answers of Worksheet

	 I.	 1.  (c)  2. (a)  3. (d)  4. (b)  5. (a)
	 II.	 1.	 (d)  2. (e)  3. (b)  4. (a)  5. (c)
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Chapter 8

Smart Internet

DO AND LEARN

1.	Fill in the blanks.
	 Ans.	 (a)	 Internet stands for Interconnected Network.
		  (b)	   FTP   is useful for finding and copying software files, articles 

and other types of data.
		  (c)	 A  blogger  is someone who runs and controls a blog.
		  (d)	  Cyber ethics  is a set of moral choices that individuals make 

when using Internet-capable technologies and digital media.
		  (e)	   Worm   is a type of malware that involves an attacker locking 

the victim’s computer system files.

2.	Write True (T) or False (F).
	 Ans.	 (a)	 Instant messagingis a service that allows users to  

communicate over the internet.	 T
		  (b)	 It is very difficult to maintain data backup, disaster 

recovery and business continuity with cloud computing.	 F
		  (c)	 A blog contains the publishing date, author reference, 

categories, and tags.	 T

		  (d)	 Do use the Internet to communicate with strangers.	 F

		  (e)	 AI can replace humans.	 F

3.	Tick () the correct option.
	 Ans.	 (a)	 Internet uses a protocol called the IP, which stands for Internet 

Protocol.		
	 (i)	 Intake Protocol	 (ii)	 Interesting Protocol
	 (iii)	 Internet Protocol	 (iv)	 Informative Protocol
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		  (b)	  ARPANET  is considered the first known group of 
interconnected computers.

	 (i)	 PARANET	 (ii)	 RAPANET
	 (iii)	 APRANET	 (iv)	 ARPANET
		  (c)	 Blog is short for  Weblog .
	 (i)	 Web blog	 (ii)	 Weblog
	 (iii)	 Blogweb	 (iv)	 None of these
		  (d)	  Phishing  is a form of fraud where fraudulent e-mails are sent 

that resemble e-mails from reputable sources.
	 (i)	 Ransomware	 (ii)	 Malware
	 (iii)	 Phishing	 (iv)	 Social Engineering
		  (e)	 Extra logins, new passwords, application security are all 

examples of Critical Infrastructure Security.
	 (i)	 Cloud Security
	 (ii)	 Application Security	
	 (iii)	 Network Security
	 (iv)	 Critical Infrastructure Security
		  (f)	 Which of the following is an example of Artificial Intelligence?
	 (i)	 Siri	 (ii)	 Cortona
	 (iii)	 Both (i) and (ii)	 (iv)	 Neither (i) nor (ii)

4.	Answer the following questions.
	 (a)	 What do you understand by cloud computing? Discuss its 

advantages and disadvantages.
	 Ans.	 Cloud computing means that instead of all the computer hardware 

and software you’re using sitting on your desktop, or somewhere 
inside your company’s network, it’s provided to you as a service by 
another company via the Internet.

		  Advantages of Cloud Computing
		  	 Less costs: The services are free from capital expenditure. 



Living with Computers TRM330

		  	 24 × 7 availability: Most of the cloud providers are reliable in 
offering their services.

		  	 All over functioning: Cloud computing offers the advantage of 
working from anywhere across the globe, as long as you have 
an Internet connection.

		  	 Automated updates on software: In cloud computing, the server 
suppliers regularly update your software including the 
updates on security.

		  	 Security: Cloud computing offers great security when any 
sensitive data has been lost.

		  	 Disadvantages of Cloud Computing
		  	 Network connection dependency: In order to get the benefits of  

cloud computing, your business must always have an Internet 
connection. You need a network to be able to use your virtual 
machines. If you lose your network connection because of a 
storm or an outage, you may experience some downtime. 

		  	 Limited features: Not all cloud providers are created equally. 

		  	 Loss of control: You are essentially trusting another party to take 
care of your data. 

		  	 Security: Cloud hacking cases have shown that not all cloud 
providers are as secure as they claim to be.

		  	 Technical issues: If you experience any technical issues, you 
have no choice but to call your service provider’s technical 
support for help.

	 (b)	 Differentiate between blogs and websites.
	 Ans.	 �Blog is an online journal or website displaying information in reverse 

chronological order. It is a platform where a writer or group of 
writers share their views on any subject.

		  Website is a group of web pages on any topic containing information 
about the topic.
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	 (c)	 Why is it important to be safe online? Mention any two reasons.
	 Ans.	� It is very important to stay safe online because it can lead to a data 

beach and can lead to a lot social, business and personal risk.
	 (d)	 Write briefly about the following:
		  (i)	 Blog structure
		  (ii)	 Cyber ethics
		 (iii)	 Artificial Intelligence
	 Ans.	 (i)	 Blog Structure:  The appearance of blogs changed over time, 

and nowadays blogs include different items. But most blogs 
include some standard features and structure. Here are 
common features that a typical blog will include:

			   	 Header with the menu or navigation bar
			   	 Main content area with highlighted or latest blog posts
			   	 Sidebar with social profiles, favourite content, etc.
			   	 Footer with relevant links like a disclaimer, privacy policy, 

contact page, etc.

		  (ii)	 Cyber Ethics:  Cyber ethics is a set of moral choices that 
individuals make when using Internet-capable technologies 
and digital media. The acceptable behaviour in the real world 
is also acceptable in cyberspace. Examples of moral conduct 
in both physical and virtual environment include showing 
respect for others, being honest, not stealing from others, etc.

		  (iii)	 Artificial Intelligence:  Artificial Intelligence (AI) is an area 
of computer science that emphasises on the creation of 
intelligent machines that can work and react like humans. 
It includes learning (the acquisition of information and rules 
for using the information), reasoning (using rules to reach 
approximate or definite conclusions) and self-correction. 

			   AI can be categorised as either weak or strong. Weak AI is an 
AI system that is designed and trained for a particular task. 
Virtual personal assistants, such as Apple’s Siri, are a form of 
weak AI.
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			   Strong AI is an AI system with generalised human cognitive abilities. 
When presented with an unfamiliar task, a strong AI system is 
able to find a solution without human intervention.

	 (e)	 Name any two types of cyber threats. Write briefly about each.
	 Ans.	 1.	 Ransomware is a type of malware that involves an attacker 

locking the victim’s computer system files – typically through 
encryption – and demanding a payment to decrypt and unlock 
them.

		  2.	 Malware is any file or program used to harm a computer user, 
such as worms, computer viruses, Trojan horses and spyware.

	 (f)	 Naman is working on his Science project given by his school 
teacher. He needs to prepare a PowerPoint presentation and 
requires relevant pictures. He has downloaded some protected 
pictures from Internet for his personal use. What’s wrong with this 
act of Naman and why?

	 Ans.	 Naman is not following cyber ethics. All intellectual property has 
copyright laws and he cannot copy any material from any website 
without permission.

	 (g)	 Karina was typing an e-mail to be sent to her friend. She attached 
some pictures and audio files (downloaded from the Internet) 
with the mail. Suddenly, her computer started showing irrelevant 
symbols and messages. What could have gone wrong with Karina’s 
computer? What should she do to avoid any such thing in future?

	 Ans.	 Karina’s computer might be attacked by malware. She should use a 
good anti-virus software that protects her computer from malware 
attacks.
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Answers of Suggested Class Activities
Students can do these activities on their own.

Answers of Worksheet

	 I.  	 1.  TCP/IP  2.  ARPANET  3.  Telnet  4.  Weblog
		  5.  Jorn Barger
	 II.  	 1.  ARPANET  2.  WEBLOG  3.  WEBSITE  4.  CLOUD
		  5.  CYBER ETHICS
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TESTING TIME – 3
(BASED ON LESSONS 7 AND 8)

1.	Choose the correct option.
	 Ans.	 (a)	 Which of the following is not a business app?
	 (i)	 Adobe Reader
	 (ii)	 Facebook Pages Manager
	 (iii)	 Angry Birds
	 (iv)	 Indeed Job Search
		  (b)	 Which of the following is an entertainment app?
	 (i)	 Amazon Prime Video	 (ii)	 Netflix
	 (iii)	 Dubsmash	 (iv)	 All of these
		  (c)	 Which of the following is not a type of networking?
	 (i)	 LAN	 (ii)	 MAN
	 (iii)	 RAN	 (iv)	 PAN
		  (d)	 A computer network that enables communication between 

computers in the range of a particular person, often covering 
an area of 10 metres. 

	 (i)	 LAN	 (ii)	 MAN
	 (iii)	 RAN	 (iv)	 PAN
		  (e)	 Software applications that behave like native applications.
	 (i)	 Hybrid apps	 (ii)	 Web apps
	 (iii)	 Educational apps	 (iv)	 None of these

2.	Write whether true or false.
	 Ans.	 (a)	 Solitaire is an example of application of Artificial
				   Intelligence.	   False 
		  (b)	 Native apps are very slow.	   False 
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		  (c)	 A computer network is a group of cables connected to 
each other.	   False 

		  (d)	 Local area networks are very expensive.	   False 
		  (e)	 A metropolitan area network (MAN) may span an 

entire city or campus.	   False 

3.	Answer the following questions briefly.
	 (a)	 Give one example of each of the following:
		  (i)	 Native app
		  (ii)	 Hybrid app
		 (iii)	 Artificial Intelligence
	 Ans.	 (i) Angry Birds  (ii) Gmail  (iii) Spam filters

	 (b)	 What are the advantages of hybrid apps over native apps?
	 Ans.	 Advantages of Hybrid Apps
		    Easy to build
		    Much cheaper than a native app
		    Single app for all platforms
		    No browser needed
		    Can usually access device utilities using an API
		    Faster to develop than native apps
	 (c)	 Write a short note on History of Internet.
	 Ans.	 �The Internet originated with the U.S. government, which began 

building a computer network in the 1960s known as ARPANET. 
ARPANET is considered the first known group of interconnected 
computers. This system was used to transfer confidential data 
in the military. This data sharing technology was then opened 
to educational institutes in the United States. The system was 
replaced by new networks operated by commercial Internet service 
providers in 1995. The Internet was brought to the public on a 
larger scale at around this time.
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	 (d)	 How do you view an app on a phone or tablet? Write steps.
	 Ans.	 �1.	 Download the MIT A12 Companion app from the Google Play 

Store and install it on your phone or tablet.
		  2.	 Search for MIT A12 Companion on Google Play Store, https://

play. google.com/store and then install the app by clicking 
install.

		  3.	 Once you’ve installed the A12 Companion app, you can connect 
your App Inventor project to your phone or tablet for live testing. 
Be sure your computer and mobile device are connected to the 
same WiFi network.

		  4.  Return to the Designer window on you computer. Click Connect 
and choose A1 Companion from the drop-down menu.

				   A QR code and a 6-character code will appear on your computer 
screen.

		  5.  Open the A12 Companion app on your device by clicking on the 
app icon.

		  6.	 A screen will appear with the option to scan the QR code or 
type in the six character code.

		  7.	 If you choose to scan the code, press the blue scan QR code 
button for the scanner to launch. Scan the QR code. Wait a 
few seconds for your app to open on your mobile device. If you 
choose to use the code, type it into the white text box, click the 
orange button afterwards.

	 (e)	 Write briefly about any two applications of AI.
	 Ans.	 Artificial Intelligence in Business Management
		    Spam filters
		    Smart e-mail categorisation
		    Voice to text features
		    Smart personal assistants, such as Siri, Cortana and Google Now
		    Automated responders and online customer support
		    Process automation
		    Sales and business forecasting
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		    Security surveillance
		    Smart devices that adjust according to behaviour

		  Artificial intelligence in E-commerce
		    Smart searches and relevance features
		    Personalisation as a service
		    Product recommendations and purchase predictions
		    Fraud detection and prevention for online transactions
		    Dynamic price optimisation
4.	Write full forms of the following:
	 Ans.	 (a)	 AI	    Artificial Intelligence   
		  (b)	 Blog	               Weblog              
		  (c)	 App	            Application           

5.	Answer the following questions.
	 (a)	 Mention the advantages of native apps.
	 Ans.	 1.  Natives are very fast
		  2.  Easily distributed in Google, Apple app stores
		  3.  More interactive and intuitive
		  4.  Easy interaction with any feature of the phone
	 (b)	 Give any two examples of:
		  1.	 Hybrid Apps	
		  2.	 Gaming Apps
		  3.	 Educational Apps	
	 Ans.	 (i)	� Hybrid Apps:  HTML, CSS and JavaScript.
		  (ii)	 Examples of game apps
	 			    Clash of Clans 
				     Candy Crush Saga 
				     Angry Birds Go 
				     Temple Run
		  (iii)	� Educational apps:  BYJU’S, Duolingo
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	 (c)	 Mention any three features of the Internet.
	 Ans.	 1.	 �World Wide Web is a part of the Internet, which supports 

hypertext documents, allowing users to view and navigate 
different types of data.

		  2.	 E-mail is the most popular reason people use the Internet. You 
can create, send and receive e-mail messages in a fraction of 
a second. You only need an e-mail program and an account 
on an Internet mail server.

		  3.	 News includes tens of thousands of newsgroups where each 
newsgroup hosts discussions on a specific topic as per the 
user’s interest.

	 (d)	 What are the uses of cloud computing? Write briefly about any one.
	 Ans.	� For Enterprises:  For businesses, the cloud has the potential to 

transform operations, as well as cut costs. Offices running computer 
networks would no longer have to deal with software installation 
for each computer, as well as licenses. Uses of the cloud include 
data storage, offering remote access to any work related data.

		  Mobility:  The most obvious use of cloud computing is the mobility 
that it brings, both to the user as well as to the corporate and 
business users. Many of us are already familiar with some cloud 
computing services, like Google Docs, or even e-mail services. 
With these apps we can access documents or mail that is not 
stored on our PCs, but is available to use because it is stored on 
a cloud, or remote location.

	 (e)	 Write a short note on Artificial Intelligence in e-commerce.
	 Ans.	 Artificial intelligence in E-commerce
		    Smart searches and relevance features
		    Personalisation as a service
		    Product recommendations and purchase predictions
		    Fraud detection and prevention for online transactions
		    Dynamic price optimisation

PROJECT WORK
	 Ans.	 Do it yourself.


	Answers238_242.pdf
	Answers250_254.pdf
	Answers260_265.pdf
	Answers272_279.pdf
	Answers288_293.pdf
	Answers300_307.pdf
	Answers314_318.pdf
	Answers328_338.pdf

